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Foreword

Digital communication offers so many advantages over analog communication that
the majority of today's communications systems are digital.

Unlike analog communication systems, digital systems do not require accurate
recovery of the transmitted waveform at the receiver end. Instead, the receiver
periodically detects which waveform is being transmitted, among a limited number
of possible waveforms, and maps the detected waveform back to the data it
represents. This allows extremely low error rates, even when the signal has been
corrupted by noise.

The digital circuits are often implemented using application specific integrated
circuits (ASIC) and field-programmable gate arrays (FPGA). Although this
"system-on-a-chip" approach is very effective for commercial and military
applications, the resulting systems do not allow access to internal signals and data
and are therefore poorly suited for educational use. It is for this reason that Lab-Volt
designed the Communications Technologies Training System.

The Lab-Volt Communications Technologies Training System, Model 8087, is a
state-of-the-art communications training system. Specially designed for hands-on
training, it facilitates the study of many different types of digital
modulation/demodulation technologies such as PAM, PWM, PPM, PCM, Delta
Modulation, ASK, FSK, and BPSK as well as spectrally efficient technologies such
as QPSK, QAM, and ADSL. The system is designed to reflect the standards
commonly used in modern communications systems.

Unlike conventional, hardware-based training systems that use a variety of physical
modules to implement different technologies and instruments, the Communications
Technologies Training System is based on a Reconfigurable Training Module (RTM)
and the Lab-Volt Communications Technologies (LVCT) software, providing
tremendous flexibility at a reduced cost.

Each of the communications technologies to be studied is provided as an application
that can be selected from a menu. Once loaded into the LVCT software, the selected
application configures the RTM to implement the communications technology, and
provides a specially designed user interface for the student.

The LVCT software provides settings for full user control over the operating
parameters of each communications technology application. Functional block
diagrams for the circuits involved are shown on screen. The digital or analog signals
at various points in the circuits can be viewed and analyzed using the virtual
instruments included in the software. In addition, some of these signals are made
available at physical connectors on the RTM and can be displayed and measured
using conventional instruments.

The courseware for the Communications Technologies Training System consists of
a series of student manuals covering the different technologies as well as instructor
guides that provide the answers to procedure step questions and to review
questions. The Communications Technologies Training System and the
accompanying courseware provide a complete study program for these key
information-age technologies.
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Courseware Outline

BASIC MODEMS AND DATA TRANSMISSION (ASK / FSK / BPSK)

Unit 1

Unit 2

Unit 3

Unit 4

Baseband Data Transmission
Baseband data transmission. Pseudo-random binary sequences.
Ex. 1-1 Pseudo-Random Binary Sequences
Test signals. Characteristics of random data. PRBS
Characteristics.
Amplitude shift keying (ASK)
Disadvantages of baseband data transmission. Data transmission using
modulation/demodulation. Amplitude shift keying (ASK). Types of
demodulation. Units of data transmission rate. ASK performance.
Ex. 2-1 Generation and Reception of ASK Signals
Generating ASK signals. The spectra of ASK signals. ASK signal
demodulation.
Frequency shift keying (FSK)

Frequency shift keying (FSK). FSK communications standards. FSK
performance.

Ex. 3-1 FSK Principles
FSK modulation. Time-domain characteristics of FSK signals.
Frequency-domain characteristics of FSK signals. FSK
demodulation.

Ex. 3-2 Bell 202 Modem (1200 baud)

The Bell 202 and CCITT V.23 MODE 2 modem standards.

Binary Phase Shift Keying (BPSK)

Comparison of ASK, FSK, and BPSK. BPSK performance.

Ex. 4-1 Generation and Demodulation of BPSK Signals
Binary phase shift keying. Generation of BPSK signals. Time and
frequency characteristics of BPSK signals. Demodulation of BPSK

signals. The BPSK Demodulator. The phase-locked loop (PLL).
The Costas loop mixer.
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Courseware Outline

BASIC MODEMS AND DATA TRANSMISSION (ASK / FSK / BPSK)

Unit5 Troubleshooting Basic Modems
Troubleshooting communications equipment. Troubleshooting activities.
Ex. 5-1 Troubleshooting an ASK Communication System

Signal flow tracing. The divide-in-half method. A systematic
troubleshooting procedure. Troubleshooting the ASK application.

Ex. 5-2 Troubleshooting an FSK Modem
Troubleshooting the FSK application.

Ex. 5-3 Troubleshooting a BPSK Communication System
Troubleshooting the BPSK application.

Appendix A Glossary of New Terms
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Exercise 5 - 1

Troubleshooting an ASK Communication System

EXERCISE OBJECTIVE

DISCUSSION OUTLINE

DISCUSSION

When you have completed this exercise, you will be able to apply a systematic
technique of signal flow tracing to diagnose instructor-inserted faults in the ASK
application.

The Discussion of this exercise covers the following points:

= Signal flow tracing

®= The divide-in-half method

= A systematic troubleshooting procedure
=  Troubleshooting the ASK application

Signal flow tracing

Signal flow tracing is the principal technique applied in troubleshooting, once a
problem has been determined and enough information concerning the problem
and its symptoms has been gathered. When performing troubleshooting
exercises with the Communications Technologies Training System, it is important
to refer to the System Diagram as well as to the block diagrams of each virtual
module showing the locations of the test points. In addition, reviewing previous
exercises can provide valuable information concerning system operation, and
lead to more efficient troubleshooting.

The technique of signal flow tracing consists of analyzing signals at different
points along their path. In some cases, an oscilloscope and a function generator
are the only test equipment needed to troubleshoot digital communications
equipment. In other cases, instruments such as a logic analyzer and a spectrum
analyzer will be required.

The choice of which signal to analyze, and where to analyze it, should never be
done on a random basis. A straight-forward, logical approach leads to quicker
identification and correction of a problem. Knowing the operating principles of the
equipment also reduces the time and effort required to diagnose a fault.

Signal flow tracing can be approached in two ways. They are basically the same
except for the direction followed in analysis:

e Signal flow tracing from input to output

¢ Signal flow tracing from output to input

Depending on the ability and training of the troubleshooter, and the functional
complexity of the equipment, one or the other of the two approaches will be
preferred. Extensive knowledge of equipment operating principles is necessary to
trace signals from output to input, while troubleshooting equipment with only one
output and multiple inputs can often be better performed in this way.
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Ex. 5-1 — Troubleshooting an ASK Communication System ¢ Discussion

114

In this manual, we suggest you perform signal flow tracing from input to output.
We suggest this approach for the following reasons:

e The approach is well adapted to the communications technologies
presented in this manual.

e |t is the best method for students who have little experience in
troubleshooting.

The divide-in-half method

A more rapid technique used by experienced personnel is the divide-in-half
method. Basically, this method requires that the input and output of the
equipment be checked to verify defective operation. Next, the complete circuit
path is divided in half and signals near the center are checked to determine if the
problem is in the first or the second half. Following this, the defective section is
again divided in half to further locate the problem. This successive divide-in-half
approach is applied until the last remaining functional block is checked and the
fault located. Figure 5-1 illustrates the procedure for a problem located at
functional block B. The dotted lines show where signals are checked and the
circled numbers indicate the steps in sequential order.

©)

o
x

NOT OK
© ¢ -
OIK NO'II' OK

-

PROBLEM
LOCATION

Figure 5-1. The divide-in-half method of troubleshooting.

A systematic troubleshooting procedure
A systematic troubleshooting procedure is summarized in the following steps:

1. Observe the problem and note its symptoms. Using various tests, identify the
module(s) or mode(s) which may be defective. If possible, perform a visual
inspection for loose or damaged wires, connectors and components.

2. Check the power supplied to each suspected module and note all status
LEDs and other indicators. In the Communications Technologies Training
System, the RTM has a LED to indicate that power is supplied to the module,
and each of the plug-in modules has a status (“OK”) LED that lights when the
module is detected by the software.
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Ex. 5-1 — Troubleshooting an ASK Communication System ¢ Procedure Outline

3. Apply the appropriate signals and use signal flow tracing within the circuits
suspected to be defective in order to locate a defective part of circuitry.

4. Verify if there are other branches of circuitry meeting at the point where
defective operation was discovered. If so, verify that these branches are
operating normally before concluding that the part of circuitry located in the
previous steps is really defective.

5. Once a defective part of circuitry has been located, make sure that its
malfunction plausibly explains the problem observed. If not, there may be
another defective part of circuitry that contributes to the problem.

6. Diagnose the problem.

Note: This procedure is summarized on the Troubleshooting Worksheet at the end of
each exercise.

Of the many different types of faults, the most difficult to identify are those that do
not appear to prevent the system from working properly. This may be the case
when a fault affects only certain controls or certain operating modes of a module,
or when the problem is noticeable only under certain conditions. In these cases,
familiarity with the nature of the signals and with the system's operation is
essential. During the troubleshooting procedure, it is best to follow the signal flow
from the system's input to output while varying the operation parameters.

Troubleshooting the ASK application

The ASK application is the simplest of the applications presented in this manual.
Once you have identified the defective circuit (ASK Modulator or ASK
Demodulator), signal flow tracing from output to input should allow you to rapidly
locate the fault and diagnose the problem.

PROCEDURE OUTLINE The Procedure is divided into the following sections:

=  Set up and connections
®= Troubleshooting faults in an ASK communication system

PROCEDURE Set up and connections

1. Turn on the RTM Power Supply and the RTM and make sure the RTM power
LED is lit.

File » Restore Default Settings 2. Start the LVCT software. In the Application Selection box, choose ASK and
returns all settings to their click OK. This begins a new session with all settings set to their default
default values, but does not values and with all faults deactivated.
deactivate activated faults.
Tip: If the software is already running, choose Exit in the File menu and restart
LVCT to begin a new session with all faults deactivated.

Labypolt: Basic Modems and Data Transmission (ASK / FSK / BPSK) 115



Ex. 5-1 — Troubleshooting an ASK Communication System ¢ Procedure

3. Make the Synchro external connections shown on the System Diagram tab of
the software. For details of connections to the Reconfigurable Training
Module, refer to the RTM Connections tab of the software.

Tip: Click the Synchro button to show the required external connections.

4. As an option, use a conventional oscilloscope during this exercise to observe
any of the outputs on the RTM (refer to the RTM Connections tab of the
software for the available outputs). Use BNC T-connectors where necessary.

Troubleshooting faults in an ASK communication system

5. Complete the upper section of the troubleshooting worksheet.

6. Make the following settings:

Binary Sequence Generator:

Generation Mode.................. Pseudo-Random
0 TP 2

BitRate .......cooeevveeiiieeeeenn. 500 bit/s
Delay...ocooeeiiiiiiiiieeee 0ms

Function .......ccccociiiiiiiie. Sine
Output Level..........oooeee 1.2V
Frequency.......cccccoovienennnne 1500 Hz

7. Click the ASK Modulator tab in order to display the ASK Modulator diagram.

Show the Probes bar (click # in the toolbar or choose View » Probes Bar).
Connect the probes as follows:

Oscilloscope Probe  Connect to Signal
1 TP2 DATA INPUT
2 TP5 MODULATOR OUTPUT
E TP3 BSG SYNC. OUTPUT
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Ex. 5-1 — Troubleshooting an ASK Communication System ¢ Conclusion

8. Show the Oscilloscope (click in the toolbar or choose Instruments »
Oscilloscope). Figure 1-6 shows an example of what you should observe.

Oscilloscope Settings:
Channel 1.
Channel 2......
Channel E ...
Time Base..........
Trigger Slope
Trigger Level
Trigger SOUCE .......cuuvevvereeeererreeneines Ext

Data

ASK signal

Sync.

Figure 5-2. Data and ASK signals.

9. Observe the signal at each of the test points of the ASK Modulator and the
ASK Demodulator. While doing this, vary the parameters of the input signals
in order to become very familiar with the operation of the module.

10. Ask the instructor to activate a fault.

11. Carry out the Troubleshooting Procedure in order to locate the fault and
diagnose the problem.

12. If desired, ask your instructor to activate another fault. Troubleshoot the
new fault using a copy of the Troubleshooting Worksheet.

13. When you have finished using the system, exit the LVCT software and turn
off the equipment.

CONCLUSION In this exercise, you used a systematic, step-by-step troubleshooting method to
locate a fault inserted in the ASK application.

This exercise has allowed you to acquire useful knowledge concerning
troubleshooting, and you have been able to verify that a sound approach leads to
quicker identification of the problem source. While you should not neglect any
personal talents for troubleshooting that you may have discovered, it is important
to combine these talents with the fundamental principles given in the exercise.
This will reduce the chances of making errors when troubleshooting.
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Ex. 5-1 — Troubleshooting an ASK Communication System ¢ Review Questions

REVIEW QUESTIONS

118

1.

Define troubleshooting.

What are two fundamental steps that should be used as a guide in any
troubleshooting job?

What are the four levels of activity designed to identify, locate, and correct a
problem? List them in the order in which they are performed during
troubleshooting.

Why is signal flow tracing from output to input instead of from input to output
a more difficult method to apply in troubleshooting?

In certain cases, a fault may not appear to prevent a system from working
properly. What approach should you take in this case?
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Ex. 5-1 — Troubleshooting an ASK Communication System ¢ Troubleshooting Worksheet

TROUBLESHOOTING WORKSHEET

Student’s Name:

Instructor's Name:

Fault:”

Troubleshooting Procedure:

Identify the defective module(s) or mode(s) and check visually for damage.

Verify that power supplied to all modules. Note all status LEDs and other indicators.
Apply the appropriate signals and use signal flow tracing to locate the problem.
Verify any other input branch, if present.

Make sure the malfunction located plausibly explains the problem observed.

o ok~ w b=

Diagnose the problem.

Problem Description and Symptoms:

Defective circuit:

Diagnosis:

Instructor's Comments:

Notes:

* At instructor’s discretion
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Unit 5 — Troubleshooting Basic Modems ¢ Unit Test

Unit Test

1. Troubleshooting communications equipment is basically the same as
troubleshooting any other electrical, electronic, or mechanical device.

a. True.
b. False.

2. Before troubleshooting any equipment the best way to start is to

a. check that the power is on.

b. call the manufacturer of the equipment.

c. read through the instruction manual to learn how the equipment
operates.

d. check that the power is off.

3. To successfully perform troubleshooting it is necessary to

have had some experience operating the particular equipment.
understand the equipment and its operation.

talk to the equipment manufacturer.

have the instruction manual of the equipment.

aoow

4. The two fundamental rules that serve as a guide for troubleshooting are

a. read the instruction manual and use your personal initiative.

b. observe the symptoms of the problem and identify the specific functional
blocks related to the problem.

c. learn how the system functions and substitute defective parts in the
system.

d. none of the above.

5. Locating and diagnosing equipment malfunctions by systematic checking is

known as

a. regular maintenance.
b. equipment checking.
C. equipment repair.

d. troubleshooting.

6. Signal flow tracing is best performed using

a random basis approach.

only the imagination of the troubleshooter.
a straight-forward logical approach.

the divide-in-half method.

aoow
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Unit 5 — Troubleshooting Basic Modems ¢ Unit Test

7. Signal flow tracing from output to input

is exactly the same as signal flow tracing from input to output.

is faster than the divide-by-half method.

requires extensive knowledge of equipment operating principles.
is a method used only to maintain communications equipment.

cooo

8. The divide-in-half technique of troubleshooting

is well adapted for use by inexperienced personnel.

is unsuitable for troubleshooting communications equipment.
is rapid, but requires good knowledge of the equipment.
requires much more time than other methods.

aoow

9. One of the first things to verify when troubleshooting is

a. the equipment's power input.

b. the electric company's line voltage.
c. the frequency of the ac power circuit.
d. none of the above.

10. A fault may not appear to prevent a system from working properly. In this
case, you

a. use the divide in half method to troubleshoot the system.

b. follow the signal flow from the system's input to its output while varying
the operation parameters.

c. letthe equipment warm up and take a coffee break.

d. call your instructor and ask him to insert a fault in your system.
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Exercise 5-1

Troubleshooting an ASK Communication System

Exercise 5-1

ANSWERS TO REVIEW
QUESTIONS

14

Troubleshooting an ASK Communication
System

1. Troubleshooting is the act of locating and diagnosing malfunctions or
breakdowns in equipment by means of systematic checking or analysis.

2. The two fundamental steps are: first, observe the symptoms of the problem,
and second, relate the problem to specific functional blocks.

3. 1. System level observations and tests

N

Signal flow tracing

w

Signal and component measurements

4. Module or component substitution and replacement

4, It is a more difficult method to apply because extensive knowledge of
equipment operating principles is necessary. Troubleshooting from output to
input means that you must decide whether the output is correct based upon
your theoretical knowledge and practical experience. This may be insufficient
when working with unfamiliar equipment. When troubleshooting from input to
output, you begin with a known signal and you check whether or not the
following signals is a correctly transformed version of this known signal.

5. In this case, it is best to follow the signal flow from the system’s input to its
output while varying the operation parameters.
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